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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.
Our mission is to:
1. Provide a Superior Customer Experience
• offer the best product quality and support
2. Make Cool Practical Technology
• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a
special group. Our employees truly care about doing a great job and delivering a high quality customer
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our
behavior:
1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and
it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in
times of company or customer crisis - do what you know in your heart is right. (You may rent
helicopters if necessary.)
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Introduction
Thank you for purchasing the Ross Video RCP-NKM Remote Control Panel. This remote control panel enables you
to control a routing switcher system from one point. With Ross Video’s reputation for delivering leading-edge
routing switcher equipment and our unsurpassed level of customer service and support, you can look forward to
many years of reliable broadcasting. Please read this thoroughly and retain it for future reference.
The RCP-NKM provides flexible connectivity of additional remote control panels and multi-page menu
programming.

Overview of this User Guide
This is for installers, and operators of the Ross Video RCP-NKM. It provides instructions on how to connect the
RCP-NKM to your routing switcher system, how to set up a configuration document for the RCP-NKM using
DashBoard, and how to operate it. It assumes that you are experienced with general broadcast concepts, and that
you are familiar with the planning requirements for a routing switcher system.
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RCP-NKM Overview
Features
The RCP-NKM Remote Control Panel provides the following features:
• 40 programmable keys (function, backlighting level)
• 16 character × 2 line backlit LCD
• operation in XY and cutbus modes
• up to 32 router levels may be controlled
• virtual routing and resource management
• macros
• panel linking with other remote control panels
• DashBoard support for easy creation of configuration documents
• firmware is fully upgradeable using DashBoard
• slim modular design integrates with NK Series devices via T-Bus using straight CAT5 Ethernet cables
• custom transparent labels under keys
• up to 250 pages of programmable menus including navigation keys
• assignable functions of destination, source, crosspoint, level, breakaway, breakaway step, macro, protect, take,
chop, shift, de-assign, machine control, panel lock, menu link, and menu navigation

Typical System Equipment
The RCP-NKM is used when you require advanced control functions from a single point. Using DashBoard, you
can program up to 250 menus on the same remote control panel. At each menu, the function of particular keys may
change depending on the assignment. These parameters can be saved in a configuration document and sent to an
RCP-NKM at any time using DashBoard. Therefore, if an RCP-NKM is used in a number of different operating
scenarios, the configuration can be changed easily and quickly.
Typical equipment that is used in an NK Series routing switcher system when an RCP-NKM is used includes:
• any of the NK Series routing switchers with its appropriate power supply (for more information see the
documentation provided with your NK Series routing switcher)
• an NK-IPS Network Bridge
• a PC running DashBoard, connected via a CAT5 Ethernet cable to the NK-IPS
• standard source and destination equipment (for example, cameras, VTRs, servers)
Notes
Keep the following in mind:
• If you are connecting the PC directly to the NK-IPS, use a crossover CAT5 Ethernet cable.
• If you are connecting the PC indirectly via an Ethernet switch to the NK-IPS, use a straight-through CAT5
Ethernet cable.
• The NK-IPS and PC with DashBoard are only required for setting up the configuration document, then sending
this to the device. However, you can use the NK Switchboard feature in DashBoard to control and monitor a
routing switcher system.
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System Overview
A routing switcher system may use distributed control across the internet, a LAN, or a VPN. The routing switcher
system shown in Figure 2.1 has been simplified.
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Figure 2.1 Layout showing a simplified routing switcher system with an RCP-NKM
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 All T-Bus connections between NK Series devices use straight-through CAT5 cables.

How the RCP-NKM and Routing Switchers Communicate
Switching
The RCP-NKM sends a switch request message to the routing switcher. The routing switcher recognises the
request, sets the crosspoint, then sends a response to the RCP-NKM.

Data Storage
The RCP-NKM stores information on the menu, destination, level, breakaway, and machine control status. The
routing switcher stores the crosspoint status in its internal memory.
When the routing switcher system is powered up, the routing switcher restores its crosspoint status. The RCP-NKM
requests the status of the routing switcher. The routing switcher sends the status of the crosspoints to the
RCP-NKM
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Installation
Unpacking the Equipment
On receiving your RCP-NKM, check the contents against the packing list. Make sure that all equipment itemized on
the packing list is present and that there are no signs of damage before you start installing the RCP-NKM into your
system.
If anything is missing or damaged, contact your Ross Video office immediately to obtain the correct warranty
service procedures. This ensures prompt assistance, minimal turnaround time, and avoids any freight issues.
We recommend that the equipment is installed by qualified and experienced personnel, to any relevant standards
and approvals.

General
These installation guidelines assume the following:
• The relevant NK Series equipment has been installed into a ventilated rack frame. The relative humidity in the
environment of the equipment should be < 70% (non-condensing).
• The routing switcher system has been well planned and designed. Consideration must be given to inputs and
outputs across multiple router levels, and typical operating scenarios for breakaways.
• Correct IP addresses have been assigned to the equipment, where required.
• The routing switchers are connected to physical inputs and outputs, and have appropriate NK Series power
supplies.
• All NK Series equipment connected in the routing switcher system have firmware v2.00 or later. For information
on updating the firmware in a device see the readme file that comes with the firmware. To check for the latest
firmware versions, contact Ross Video Technical Support.

Installing the RCP-NKM
The RCP-NKM is powered using the 5 V 2 A power supply provided. This power supply connects directly to the
AC mains supply
Warning — Ensure that the AC mains supply complies with the PSU specification before making the
connection.
Warning — An earthed neutral mains supply and residual current device is recommended for safe
operation.

Installing the Routing Switcher System in a Daisy-Chain Layout
You may connect NK Series equipment in a daisy-chain layout. The items are connected via the T-Bus control
system. However, if the T-Bus chain is broken, for example, by accidentally disconnecting a cable, downstream
devices are also disconnected. T-Bus RJ-45 sockets on devices downstream from the NK-IPS are passively
connected internally, so device failure or power disconnection does not disrupt communication with other devices
in the chain.
Each T-Bus connector on the NK-IPS has an independent driver/receiver ensuring that each of the eight T-Bus
connectors will not be affected by a device failure on any other connector.
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Figure 3.2 Remote control panels connected to NK Series equipment in a daisy-chain layout
To connect the remote control panel in a daisy-chain layout

1. Install the RCP-NKM into the rack frame, then fix in place with appropriate fasteners.
2. Connect a straight-through CAT5 Ethernet cable between a T-BUS connector on the rear of the RCP-NKM and
a T-BUS connector on the rear of another remote control panel, an NK Series routing switcher, or an NK-IPS
(see Figure 3.2).
If required, make a similar connection between the remaining T-BUS connector on the rear panel of the
RCP-NKM and a T-BUS connector on the rear panel of another item of NK Series equipment.
3. Connect the 5 V 2 A power supply provided to the POWER connector on the rear panels of the RCP-NKM.
4. Connect the cable from the power supply to a suitable AC mains supply.

 The RCP-NKM is designed for installation into a standard 19" equipment rack. It has integrated rack ears,
allowing it to be screwed in using standard screws and cage nuts.

Installing the Routing Switcher System in a Star Layout
You may connect NK Series equipment to the NK-IPS in a star layout. The items are connected via the T-BUS
control system. If any device connected directly to the NK-IPS is disconnected, it is only the downstream devices
that become non-operational. All other devices remain operational.
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Figure 3.3 Remote control panels connected to NK Series equipment in a star layout
To connect the remote control panel in a star layout

1. Install the RCP-NKM into the rack frame, then fix in place with appropriate fasteners.
2. Connect a straight CAT5 Ethernet cable between a T-Bus connector on the rear panel of the RCP-NKM and a
T-Bus connector on the rear panel of the NK-IPS (see Figure 3.3).
3. Connect the 5 V 2 A power supply provided to the POWER connector on the rear panel of the RCP-NKM.
4. Connect the cable from the power supply to a suitable AC mains supply.
5. Connect any remaining remote control panels in this manner.

 The RCP-NKM is designed for installation into a standard 19" equipment rack. It has integrated rack ears,
allowing it to be screwed in using standard screws and cage nuts.

Connecting to the NK-IPS in the Routing Switcher System
Before you can set up and send a configuration document to the RCP-NKM, you must connect an NK-IPS to the
RCP-NKM. Once DashBoard locates the NK-IPS, the attached RCP-NKM is visible and can have configuration
documents sent to it.
Most systems automatically detect an NK-IPS if its IP address uses the same subnet as the PC running DashBoard.
However, if the device is not detected automatically, follow the steps below. For information on the NK-IPS, refer
to the documentation provided with the equipment.
To connect to the NK-IPS

1.

Launch DashBoard.

2. Use Walkabout to determine and/or change the IP address of the NK-IPS. Refer to the NK-IPS User Guide for
more information.
3. From the main toolbar in DashBoard select File > New > NK IPS Connection.
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4. Enter the IP Address of the NK-IPS you want to connect to.
5. Ensure the TCP Port field is set to 5000.
6. Click Finish.
The NK-IPS now displays as a node in the Basic Tree View of DashBoard.

Checking the Firmware Version of a Device
The RCP-NKM must operate with other devices that have v2.00 firmware or later. Firmware may be updated easily
using the DashBoard. To check for the latest firmware versions, contact Ross Video Technical Support.

Using DashBoard to Check the Firmware Version
To check the firmware version of any device using DashBoard

1. Launch DashBoard and connect to the NK-IPS.
2. In the Device Tree of DashBoard, expand the NK-IPS (or NK-NET) node to display a list of sub-nodes.

 Each sub-node is a list of devices communicating with the NK-IPS (or NK-NET).
3. Double-click the RCP-NKM node to open its interface in DashBoard.
The firmware version is reported in the top panel of the window.

Upgrading the Firmware Version of a Device
For information on upgrading the firmware version of a device, see the readme file that comes with the firmware.
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Setting Up the RCP-NKM
The RCP-NKM can be set up using the DashBoard. You must have an NK-IPS connected to the system. The
parameters for a device may be then saved to a configuration document.
For More Information on...

• checking and upgrading firmware, see “Checking the Firmware Version of a Device” on page 3–4 and
“Upgrading the Firmware Version of a Device” on page 3–4.
• saving parameters to a configuration document, see “Saving the Current Document for the RCP-NKM” on
page 4–22.

Opening the RCP-NKM Editor
 Before setting up any parameters for the RCP-NKM, ensure that all NK Series devices in the routing switcher
system have firmware v2.00 or later.
To open the RCP-NKM editor

1. Launch DashBoard and connect to the NK-IPS.
2. In the Device Tree of DashBoard, expand the NK-IPS (or NK-NET) node to display a list of sub-nodes.

 Each sub-node is a list of devices communicating with the NK-IPS (or NK-NET).
3. Double-click the RCP-NKM node to open its interface in DashBoard.

Implementing Your System Plan
An effective routing switcher system takes careful planning. If you intend to use multiple router levels across
several input and output devices, it is recommended that you use common input connectors for each source device
across the routing switchers, and common output connectors for each destination device across the routing
switchers. This methodology is shown in Figure 4.4.
The following process for setting up the RCP-NKM is recommended.
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Figure 4.4 Flow chart for setting up the RCP-NKM

Viewing and Changing Device Details
When a device attached to the NK-IPS is interrogated, a tab for the device appears in the main pane of DashBoard.
Information is read from the device and shown in the simulated RCP-NKM.
To view the details for the RCP-NKM

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
The read-only parameters for the RCP-NKM are shown in the top section of the tab of the device.
Table 4.1 Device details that are read from the RCP-NKM
Item
Serial Num (read-only)

Description
This parameter is read-only. The serial number of the device. This is set in the factory.
It is unique to the device.
If you are working on a file that is stored under File Explorer, the serial number of
the device is replaced by SAVED-FILE.

Version (read-only)

This parameter is read-only. The version status of the firmware detected in the device.
If the firmware version for any NK Series device that is connected to the RCP-NKM
is earlier than v2.00, you must upgrade the firmware in that device (see “Upgrading
the Firmware Version of a Device” on page 3–4).
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Table 4.1 Device details that are read from the RCP-NKM
Item

Description

Name (user definable)

The name for the device. The default name for the RCP-NKM is RCP-NKM. This
parameter may be changed to any name that uniquely identifies the device, for
example, RCP-NKM_1. The name may be up to 16 characters in length.

Group (user definable)

The group to which the device belongs. This parameter is used to identify items of
equipment that may be in the same location or used for a similar purpose, for
example, equipment in the same rack, or a logical grouping of modules that may be
operated as a group. The group identifier may be up to 10 digits in length.

Details (user definable)

The meaningful details of the device. This parameter is used to specifically identify
this device from other devices, for example, OBV Rack 1. The details may be up to
16 characters in length.

Address (user definable)

The address is used by each device in the routing switcher system to identify itself to
other devices during communication. The default address for an RCP-NKM is the last
two digits of the serial number, plus 100. Devices should have a unique address.
If you want to link a number of similar remote control panels together so that they
function as one remote control panel, set the same address for each remote control
panel, then set individual panel link addresses for each remote control panel (see
“Linking Remote Control Panels” on page 4–4).

To change the details for the RCP-NKM

1. In the Device Details frame, click in the field that you want to change.
2. Enter the information as required (see Table 4.1), then press Enter.
3. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

 You should save the current document regularly (see “Saving the Current Document for the RCP-NKM” on
page 4–22).

Default Configuration
Every NK Series device leaves the factory with a default configuration. This default configuration is viewed by
opening the editor for the device in the DashBoard.

Loading Default Configuration
If you have made changes to the configuration, but want to return to the default configuration, you can send the
default document to the device (see “Sending a Document to a Device” on page 4–23). You can also load the
factory defaults (see “Loading Factory Defaults” on page 4–22).

Router Levels
The RCP-NKM sends switch requests to the routing switcher. Each routing switcher is assigned a level, or number
of levels if it has been partitioned. These level assignments may be changed through the routing switcher’s
configuration editor in the DashBoard.
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Table 4.2 Default Router Levels
Router level

Name

1

Multi-definition 3G/HD/SD SDI
digital video

2

SD SDI digital video

3

AES/EBU digital audio 1

4

AES/EBU digital audio 2

5

Analog video

6

Analog audio (left)

7

Analog audio (right)

8

Machine control

Breakaways
The default breakaway is tied, that is, the first eight router levels are switched together when requested from the
RCP-NKM. If your routing switcher system does not use all of the router levels stated above, you should remove
the unused levels from the default breakaway. For more information on breakaways see “Setting Up Breakaways”
on page 4–6.

Key Assignments
By default, the 20 keys in the top row on the RCP-NKM are assigned as sources and the 20 keys in the bottom row
are assigned as destinations.

Figure 4.5 Default key assignments on the Home menu

Linking Remote Control Panels
If your routing switcher system is extensive, control of the entire system may not be possible through just one
remote control panel. If this is the case, additional remote control panels may be added, as described “Installing
the RCP-NKM” on page 3–1. You can choose to operate the remote control panels individually, or you can link the
remote control panels together so that they operate as one larger remote control panel. For more information see
“Operating Linked Remote Control Panels” on page 5–8.
You may link RCP-NKM and RCP-NKQ remote control panels together. You cannot link the RCP-NK1 with a
RCP-NKM or RCP-NKQ.
You may link up to 255 remote control panels together. When multiple remote control panels are linked, the
Address field must be the same for all linked remote control panels, and the Panel Link Address field must be
different for each remote control panel.
To link remote control panels together

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. In the Device Details frame, Address field, enter the common address (between 2 and 255) that you want all
the linked remote control panels to use.
By default, the address is set to the last two digits of the serial number, plus 100.
3. Select the Configuration tab.
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4. In the Panel Link frame, Panel Link Address field, enter the individual address (between 1 and 254) that you
want this particular remote control panel to use.
By default, the panel link address of a remote control panel is set to zero.
5. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).
6. Repeat this process for all of the remote control panels that you want to link together.

 The panel address and link address must be different for each remote control panel.

Assigning Physical Connections for Control by an RCP-NKM
Source and destination equipment is physically connected to routing switchers. This connection information must
be displayed meaningfully on the RCP-NKM. This information is set up on the Input Assigns and Output Assigns
tabs.

Selecting the Number of Inputs/Outputs
Depending on the size of the routing switchers connected, you may choose to increase or reduce the number of
input and output labels to match the size of the routing switcher, if virtual routing is not used. The number may be
changed in increments of 8.
To change the number of possible inputs and outputs

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Do one of the following:
• To change the number of inputs, select the Input Assigns tab.
• To change the number of outputs, select the Output Assigns tab.
3. Use the up and down arrows in the Number of inputs/Number of outputs field to adjust the number to match
the requirements of your routing switcher system.
4. Click Update.
5. If you want to transfer this number of inputs/outputs to the other tab, click Copy to Output Assigns/Copy to
Input Assigns.
The labels are also copied.
6. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning Input and Output Labels
To assign input and output labels

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Do one of the following:
• To change the label for an input, select the Input Assigns tab.
• To change the label for an output, select the Output Assigns tab.
3. Double-click to highlight the text in the field corresponding to the input/output to which the item of
source/destination equipment is connected.
4. Enter the name of the item of source/destination equipment.
5. Press Enter.
The name of the item of source/destination equipment appears on the corresponding key on the simulated
RCP-NKM in DashBoard.
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6. Repeat this process until all of the inputs and outputs on the routing switchers have been assigned a label for
the connected items of source and destination equipment.
7. If you want to transfer the labels for the inputs/outputs to the other tab, click Copy to Output Assigns/Copy to
Input Assigns.
The number of inputs/outputs is also copied.
8. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).
Notes
Keep the following in mind:
• If there are various router levels using this input or output number, then the label may be ambiguous if the source
or destination is different for those levels.
• You may rearrange the layout of the labels on the keys when you assign functions to the keys (see “Assigning
Functions to Keys on the RCP-NKM” on page 4–8).

Setting Up Breakaways
A breakaway selects a group of levels to be switched. The default breakaway for the RCP-NKM is the first eight
router levels switching together, that is, tied. If your routing switcher system does not use all of the pre-defined
router levels (see Table 4.2), you should disable those levels that are not used in order to prevent a breakaway
warning. If you want to switch certain router levels only, set up a custom breakaway for these levels, then assign
this to a key on the RCP-NKM (see “Assigning Functions to Keys on the RCP-NKM” on page 4–8). If you select
a breakaway that includes a level for which there is no routing switcher assigned, a breakaway warning is indicated
by an inverse B on the second line of the LCD.
To set up the breakaways

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Breakaways frame.
4. In the Tied level mask, de-select the router levels that are not used in your routing switcher system by clicking
on the numbered squares.
A selected router level is indicated by a blue square.
For example, if router levels 2 and 3 are the only levels used, you should de-select levels 1, 4, 5, 6, 7, and 8 in
the Level Mask column corresponding to Tied.
5. Double-click in the field below Tied in the Name column.
6. Enter the name of the router level that corresponds to the first custom breakaway that you want to define.
For example, enter SDI.
7. Select the corresponding router level(s) in the Level Mask column (see Table 4.2), and de-select any router
levels that are not used.
8. Define the next custom breakaway in the Name column below the breakaways that you have defined
previously. Continue until you have defined all the custom breakaways that you want to use.
9. Clear the remaining level masks from unused breakaways in the Breakaways table.
10. Scroll to the Configuration frame.
11. Click the down arrow in the Breakaway Warning Mode field, then select the breakaway with which you want
to compare the status of the router levels in the current breakaway.
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12. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window.
Notes
Keep the following in mind:
• If you click and drag across the level mask, you can rapidly select or de-select router levels.
• The breakaway defined in the first row of the Breakaway table is the default breakaway.
• You can combine more than one router level in the same breakaway. Give the breakaway a meaningful name that
covers the router levels that you want to use. Limit the name to 8 characters.
• A breakaway warning is caused by no response from the routing switcher system on one or more router levels or
a difference in status of any level in the currently selected breakaway when compared with the first level in the
breakaway
• The default breakaway and any custom breakaways may now be assigned to keys on the RCP-NKM
For More Information on...

• sending the current document to the device, see “Sending a Document to a Device” on page 4–23.
• assigning breakaways to keys, see “Assigning a Breakaway to a Key” on page 4–12.

Resetting a Custom Breakaway to the Default Breakaway Automatically After a Switch
The default breakaway is defined in the first row of the Breakaways table in the Breakaways frame. Typically, this
breakaway is tied, and switches all router levels together. If you want only certain router levels to switch, as defined
in a custom breakaway, you select that breakaway on the RCP-NKM, then make the switch. The RCP-NKM
continues to use that breakaway (as indicated by the key being illuminated) for all further switches until another
custom breakaway, or the default breakaway is selected. If you want the RCP-NKM to reset to the default
breakaway immediately after a custom breakaway is used during a switch, then you should set the RCP-NKM to
reset the breakaway.
To enable the resetting of the breakaway to the default breakaway automatically after a switch

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Configuration frame.
4. Select the Breakaway Reset check box.
5. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Setting Up Menus
Menus may be used to group certain functionality within the RCP-NKM together. You can store up to 250 menu
pages in the RCP-NKM. You can also set up what happens after an activity has been performed in a particular
menu, that is, you can define the fallback. Each menu page provides a new set of 40 keys that you may assign with
new functions.
For example, if you set up a menu containing all the breakaways, another menu containing all the destinations and
another menu containing all the sources, you can set up the menus so that once you have selected a breakaway, the
menu containing all the destinations is shown so that you can select a particular destination device. Following this,
the menu containing all the sources is shown so that you can select a particular source device. Another use may be
to define all the different classes of inputs, then assign these to menu links on the top row of keys on the RCP-NKM
for each menu page. This process can then be repeated for outputs. When this configuration is used, the top row of
keys always stays the same for each menu; it is the function of the bottom row of keys that changes from menu to
menu.
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To set up a menu

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Menu Details tab.
3. Use the up and down arrows in the Number of menus field to adjust the number to match the requirements of
your routing switcher system.
4. Click Update.
5. In the row corresponding to Menu Number 1:
a. Double-click to highlight the text in the Menu Name column, enter up to 8 characters as a meaningful
name for the menu, then press Enter.
b. Click in the Fallback Mode column, then select the option that you want from the drop list. Use the
information in Table 4.3 as a guide.
Table 4.3 Fallback Mode Options
Option
Fallback Off

Function
After a key in the menu is pressed, the RCP-NKM remains on the menu.
If you select Fallback Off, the corresponding value in the Fallback
Menu column is ignored. You must provide extra menu navigation keys
within the menu so that you can exit from the menu.

First Menu

After a key in the menu is pressed, the RCP-NKM returns to the menu
set in Menu Number 1.
If the key that is pressed is assigned as a menu link or a menu navigation
key, then the RCP-NKM goes to that menu.

Previous Menu

After a key in the menu is pressed, the RCP-NKM returns to the menu
that is was on prior to the current menu.
If the key that is pressed is assigned as a menu link or a menu navigation
key, then the RCP-NKM goes to that menu.

Specified Menu

After a key in the menu is pressed, the RCP-NKM returns to the menu
specified in the corresponding field in the Fallback Menu column.
If the key that is pressed is assigned as a menu link or a menu navigation
key, then the RCP-NKM goes to that menu.

If you have selected Specified Menu, enter the menu number in the corresponding field in the Fallback
Menu column.
6. Define the next menu in the Menu Name column below the menus that you have defined previously. Continue
until you have defined all of the menus that you want to use.
7. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

 When you move into the menu page on the RCP-NKM, any static labels that you have placed in the keys may no
longer reflect the function of the key.

Assigning Functions to Keys on the RCP-NKM
The RCP-NKM is programmed in the factory with default key assignments (see “Default Configuration” on
page 4–3). If this default key assignment is not suitable for your routing switcher system, you can easily customise
the configuration using the DashBoard and save it as a document. The available functions are listed in the
Properties pane, Function field drop list.
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The RCP-NKM may be programmed with 250 menu pages. Each menu may hold a different set of key functions.
You can assign any of the following key functions across any menu.
Table 4.4 Functions that may be assigned to keys on the RCP-NKM
Function
Destination
(Dest)

Description
The item of destination equipment that receives the physical output from the routing
switcher. The destination is selected by pressing the key, but the switch is not made until
the required source key is pressed. For more information, see “Assigning a Source or
Destination to a Key” on page 4–11.
By default, all 20 keys in the bottom row of the RCP-NKM are assigned as destinations.
If there are no destination keys assigned to the RCP-NKM, it operates in Cutbus mode (see
“Setting Up Cutbus Operation” on page 4–18).

Source

The item of source equipment that sends the physical input to the routing switcher. A
switch occurs when a source key is pressed, and the signal is routed to the currently
selected destination. For more information, see “Assigning a Source or Destination to a
Key” on page 4–11.
The function of any source key on a menu is changed when a TAKE key is assigned to the
menu (see Take).
By default, all 20 keys in the top row of the RCP-NKM are assigned as sources.

Crosspoint
(Xpoint)

A breakaway, destination, and source assigned to one key. A switch is achieved by pressing
the crosspoint key, rather than pressing a breakaway key, a destination key, then a source
key. For more information, see “Assigning a Crosspoint to a Key” on page 4–11.
The function of any crosspoint key on a menu is changed when a TAKE key is assigned to
the menu (see Take).

Level

A specific router level assigned to a key. Pressing a level key, selects that router level.
Multiple levels may be selected. If a switch is made while a level key is pressed, the switch
is made on that router level only. For more information, see “Assigning a Level to a Key”
on page 4–12.

Breakaway

A pre-defined group of router levels assigned to a key. You select a breakaway as part of
making a switch. For more information see, “Setting Up Breakaways” on page 4–6 and
“Assigning a Breakaway to a Key” on page 4–12.
If a level key is assigned for one or all of the router levels in a breakaway, then the level
keys corresponding to the router levels in the breakaway are illuminated when the
breakaway key is selected. The level keys do not illuminate when the default breakaway is
selected.
If you want to view the levels used in the current breakaway, hold the breakaway key (see
“Viewing the Breakaways Assigned to an RCP-NKM” on page 5–3). For help with
reading the levels from the hexadecimal expression, see Table 7.11.

Breakaway Step
(Brk Step)

A single key that selects the next breakaway in the Breakaway table (see “Setting Up
Breakaways” on page 4–6). For more information, see “Assigning a Breakaway Step
Key” on page 4–12.
If you want to view the levels used in the current breakaway, hold the breakaway step key
(see “Viewing the Breakaways Assigned to an RCP-NKM” on page 5–3). For help with
reading the levels from the hexadecimal expression, see Table 7.11.
The breakaway step key does not illuminate when the default breakaway is selected.

Macro

A sequence of switching events that are assigned to a key. For more information, see
“Assigning a Macro to a Key” on page 4–13.
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Table 4.4 Functions that may be assigned to keys on the RCP-NKM (Continued)
Function
Protect

Description
A single key that places a block on the current destination, preventing its use by other
sources, and other linked remote control panels. For more information, see “Assigning a
Protect Key” on page 4–14.
The protect key may also be used to lock the RCP-NKM (see “Locking the RCP-NKM”
on page 5–4).

Take

The trigger that ends a hold on a switch sequence. This enables you to press the required
breakaway, destination, then source key combination, or crosspoint key, or macro key, but
not activate the switch until TAKE is pressed. If you have a TAKE key assigned on a
menu, it affects the behavior of the menu. You must use it to activate any switch that is set
up. If you do not have a TAKE key assigned to the menu, then a switch is made as soon as
the source/crosspoint/macro key is pressed. For more information, see “Assigning a
TAKE Key” on page 4–15.

Chop

A single key that starts a slow or fast toggle between the two most recently selected
sources for a given destination. For more information, see “Assigning a CHOP Key” on
page 4–15.

Shift

An extra page of inputs and outputs for a menu. A shift key is assigned to either a source or
a destination. You need one shift key per page, therefore to have two pages of source keys,
you need to assign two source shift keys. For more information, see “Assigning a Shift to
a Key” on page 4–16.

De-assign

The DE-ASIGN button has two-fold functionality:
• A single key that provides a convenient method for disconnecting machine control ports.
For more information, see “Setting Up Machine Control” on page 4–19.
• A single key that allows you to free-up resources when they are no longer needed for a
path. For more information, see “Setting Up Virtual Routing and Resource
Management” on page 4–20.

Machine Control Key
(MC Key)

A single key that provides a convenient method for toggling reciprocal switching on and
off when machine control is used. For more information, see “Setting Up Machine
Control” on page 4–19.

Panel Lock

A single key that provides a convenient method for locking the RCP-NKM against
accidental changes. For more information, see “Assigning a Panel Lock Key” on page 4–
16.
The panel lock function may also be set using the Panel Locked check box on the
Configuration tab.

Menu Link

A link that accesses a pre-defined menu via a single key. For more information, see
“Setting Up Menus” on page 4–7 and “Assigning a Menu Link to a Key” on page 4–17.

Menu Navigation

A specific menu destination assigned to a key. You can set the key to return to Menu
Number 1 (Home), the next or previously visited menu, or go up or down a menu as
defined on the Menu Details tab. If XPoint Layer is selected, you can cycle through the
current breakaway, destination and source. For more information, see “Assigning Menu
Navigation to a Key” on page 4–17.

Unassigned

A label indicating that the key does not have any of the above key functions assigned to it,
and therefore does nothing when pressed. For more information, see “Unassigning a Key”
on page 4–18.
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Assigning a Source or Destination to a Key
Source and destination keys map the physical connections on the routing switcher to the RCP-NKM. You can
provide meaningful labels for these physical connections using the Input Assigns and Output Assigns tabs for the
RCP-NKM (see “Assigning Physical Connections for Control by an RCP-NKM” on page 4–5).
To assign a source or destination to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the source or destination.
3. In the pop-up dialog:
a. Select Destination or Source as the key type.
b. Select Default, Shift 1, or Shift 2 as the key state. Refer to “Assigning a Shift to a Key” on page 4–16.
c. Select the named destination or source as the key value.
The simulated RCP-NKM in DashBoard shows the label for the specified input/output on the selected key. If
you have assigned a name to this input/output using the Input Assigns/Output Assigns tab, this name appears
on the key.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).
Notes
Keep the following in mind:
• You can assign three physical outputs to the same key: Default, Shift1, and Shift2. When shift keys are assigned
to the RCP-NKM, the physical output assigned to that key on that shift page is used for the switch. For more
information see “Assigning a Shift to a Key” on page 4–16.
• If you have virtual routing enabled in the RCP-NKM, the output that you enter represents the virtual destination
as set up in the NK-VRC Virtual Routing Core.

Assigning a Crosspoint to a Key
When you make a switch, you need to select the level(s) that you are switching using a breakaway, the destination,
then the source. This requires three key presses. To reduce this effort and the potential for error, common switch
sequences may be set up in a crosspoint.

 You should record relevant information for the crosspoint and include this in the label for the key (see “Printing
Labels for the Front of the RCP-NKM” on page 4–23).
To assign a crosspoint to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the crosspoint.
3. In the pop-up dialog:
a. Select Crosspoint as the key type.
b. In the Output field, enter the physical output that connects to the item of destination equipment to which
you want to switch, then press Enter.
c. In the Input field, enter the physical input that connects to the item of source equipment that provides the
required signal, then press Enter.
d. In the Breakaway field, enter the breakaway level that you want to use for the switch, then press Enter.
The simulated RCP-NKM in DashBoard shows X-PNT on the selected key.
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4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Level to a Key
A level key enables you to select one router level for a switch. While a breakaway is similar, it may contain more
than one router level.
To assign a level to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the level.
3. In the pop-up dialog:
a. Select Level as the key type.
b. In the Level Value field, enter the specific router level that you want to assign to this key, then press Enter.
The simulated RCP-NKM in DashBoard shows the selected level on the key, for example Level 2.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Breakaway to a Key
When you make a switch, you need to select the level or levels that you are switching using a breakaway. The
breakaways should be set up before they are assigned to a key (see “Setting Up Breakaways” on page 4–6).
To assign a breakaway to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the breakaway.
3. In the pop-up dialog:
• Select Breakaway as the key type.
• Select the breakaway that you want to use as the key value.
The simulated RCP-NKM in DashBoard shows the name of the breakaway on the selected key, for example,
Tied.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Breakaway Step Key
An RCP-NKM may have several breakaways defined. If you want to cycle through the breakaways that have a
non-zero level mask, assign a breakaway step key to the RCP-NKM. The key for the breakaway illuminates as it is
selected. If you hold the breakaway step key for each breakaway, the levels defined in that breakaway are
represented by eight hexadecimal characters on the screen. For help with reading the levels from the hexadecimal
characters see Table 7.11.
To assign a breakaway step key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the breakaway step.
3. In the pop-up dialog:
a. Select Function Key as the key type.
b. Select Breakaway Step as the key value.
The simulated RCP-NKM in DashBoard shows BRK STEP on the selected key.
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4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Macro to a Key
If you want to perform several tasks at the press of a key, assign a macro key to the RCP-NKM, then record a macro
using this key. For more information see “Recording a Macro Using the Panel” on page 4–13. You can assign up
to 40 macros to an RCP-NKM.
To assign a macro to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the macro.
3. In the pop-up dialog:
a. Select Macro as the key type.
b. Select the Macro Name as the key value.
The simulated RCP-NKM in DashBoard shows the macro number on the selected key, for example, Macro 1.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Recording a Macro Using the Panel
Macros can be recorded using the keys on the RCP-NKM. You may record up to 112 key presses in a macro. A
macro key must be assigned on the RCP-NKM before you can use it to record the macro.
To record a macro using the panel

1. On the RCP-NKM, hold the Macro <n> key until the LCD shows MACRO RECORD and the key
illuminates.
2. Release the key.
The key flashes slowly, indicating that the RCP-NKM is now ready to record a macro.
3. Press the required keys in the correct sequence until your task is completed.
Each key acknowledges that it has been pressed by flashing briefly.
4. Press the Macro <n> key again to end the recording process.
The macro is recorded.

 If you unassign the Macro <n> key from the macro function, the recorded macro is held in memory. You can
re-assign the macro to a key using the same macro number under which the macro was recorded.
Adding to a Macro Using the Panel
You can add extra key sequences to an existing macro. You can join two existing macros together.
To add to a macro using the panel

1. On the RCP-NKM, hold the Macro <n> key until the key begins to flash rapidly, then release the key.
The key flashes slowly, indicating that the RCP-NKM is now ready to record a macro.
2. Hold the Macro <n> key again.
The selected macro is played back internally, ready to receive the additional key sequences.
3. Do one of the following:
• To add an extra key sequence, press the required keys in the correct sequence until your task is completed.
• To add an existing macro, press the key for that macro.
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Each key acknowledges that it has been pressed by flashing briefly.
4. Press the Macro <n> key again to end the recording process.
The existing macro is overwritten with the new macro.

Configuring a Macro
Macros can be configured in DashBoard using the Macro Events tab.
To configure a macro using the Macro Events tab

1. Assign a macro to a key (see “Assigning a Macro to a Key” on page 4–13).
2. Select the Macro Events tab.
3. In the Num. Rows. box of the macro, enter or select the number of events to be assigned.
4. Click Update to add the events to the Event column of the macro.
5. In the Function column, use the list to select the function to perform for the event. The options are as follows:
• Switch — performs a standard crosspoint switch.
• Macro — performs a macro within the executed macro.
• Protect — creates a protect condition on the destination of the selected crosspoint (see “Assigning a
Protect Key” on page 4–14).
6. In the Output column, perform the following:
a. Double-click the Output box.
b. Enter a destination for the event.
c. Press Enter.
7. In the Input column, perform the following:
a. Double-click the Input box.
b. Enter a source for the event.
c. Press Enter.
8. In the Level Mask column, select the level mask or masks for the device affected by the macro.
Each function can occur on any available level, independent of any other function within the same macro
event.
9. Repeat Steps 5 to 8 for any remaining events of the macro.
10. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Protect Key
To prevent switching of critical crosspoints by others, assign a protect key for use on the RCP-NKM. The protect
function ensures that the selected destination can only receive the selected source across the selected levels. Once
protected, the selected levels on a destination cannot be switched by other remote control panels (or by the same
remote control panel if Block All Panels is selected). The source is not protected, and can be freely routed to other
destinations if required. You can protect any number of destinations. For more information see “Protecting a
Destination” on page 5–5.
You can also use the protect key to lock the RCP-NKM against all key presses (see “Locking the RCP-NKM” on
page 5–4).
Assigning a Protect Key
Protect keys can be assigned using DashBoard.
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To assign a protect key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the protect key.
3. In the pop-up dialog:
a. Select Function as the key type.
b. Select Protect as the key value.
The simulated RCP-NKM in DashBoard shows PROT on the selected key.
4. Select the Configuration tab.
5. Scroll to the Configuration frame.
6. Select the mode of protection that you want for the protect key. Use the information in Table 4.5 as a guide..
Table 4.5 Protection Descriptions
Protect Mode
Block Other Panels

Description
The protected destination and level(s) cannot be switched to another source
by other remote control panels.
The protected destination and level(s) can be switched to another source on
the current remote control panel.

Block All Panels

The protected destination and level(s) cannot be switched to another source
by the current remote control panel or other remote control panels.

7. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a TAKE Key
If you want to pre-load a switch sequence, but delay the switch, assign a TAKE key on the menu. If a TAKE key is
assigned, then all switches on that menu are activated by pressing the TAKE key instead of the
source/crosspoint/macro key. You should assign a TAKE key on each menu that requires this switching type.
To assign a TAKE key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the TAKE key.
3. In the pop-up dialog:
a. Select Function as the key type.
b. Select Take.
The simulated RCP-NKM in DashBoard shows TAKE on the selected key.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a CHOP Key
If you want to toggle two different sources to the same destination, assign a CHOP key to the RCP-NKM. For
example, the destination may be the monitor that you are viewing, and the sources may be feeds from two different
camera locations. When you use the CHOP key, the toggle rate can be slow or fast (see “Toggling Between Two
Sources” on page 5–6).
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To assign a CHOP key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the CHOP key.
3. In the pop-up dialog:
a. Select Function as the key type.
b. Select Chop.
The simulated RCP-NKM in DashBoard shows CHOP on the selected key.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Shift to a Key
A shift key enables the user to access another set of sources or destinations. This is useful for switching larger
routing systems. When a shift key is enabled, the Shift 1 or Shift 2 value is used for the particular source or
destination key instead of the default value.
Table 4.6 Shift Keys
Page

Input/Output Range

Example

Default

1 to n (n  20)

10, when no shift key is set

Shift 1

(n+1) to 2n

20, when a SRC SH1 key is set

Shift 2

(2n+1) to 3n

30, when a SRC SH2 key is set

A shift key is applicable to a source or a destination key. Therefore, you may need to assign a SRC SH1 key or a
DST SH1 key. If you are using two shift pages, you must assign a SRC SH1 key and a SRC SH2, and similarly for
destinations.
To assign a shift to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the shift.
3. In the pop-up dialog:
a. Select Shift as the key type.
b. Select Shift Type as the key value.
The simulated RCP-NKM in DashBoard shows the type of shift and shift page on the selected key, for
example, SRC SH2.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Panel Lock Key
It may be necessary at times to lock the entire RCP-NKM from changes. If this function is required, assign a panel
lock key. You can also lock the RCP-NKM using the Panel Locked check box on the Configuration tab (see
“Locking an RCP-NKM” on page 4–18).
To assign a panel lock key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the panel lock.
3. In the pop-up dialog:
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a. Select Function as the key type.
b. Select Panel Lock.
The simulated RCP-NKM in DashBoard shows LOCK on the selected key.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Menu Link to a Key
You can assign a pre-defined menu to a key on the RCP-NKM. For information on how to set up a menu see
“Setting Up Menus” on page 4–7.
To assign a menu to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for the menu.
3. In the pop-up dialog:
a. Select Menu Link as the key type.
b. Select the menu that you want to use as the key value.

 Menu names are configured via the Menu Details configuration tab.
The simulated RCP-NKM in DashBoard shows the menu on the selected key, for example, CAM.
4. To configure the menu selected above, select the current menu view via the Menu Selection box.

 This box is located below the simulated RCP-NKM.
5. Assign functions to the keys in this menu (see “Assigning Functions to Keys on the RCP-NKM” on page 4–
8).
For example, if this menu is for the purpose of selecting a destination, assign the keys as destinations. You may
choose to have this destination menu fall back to a source menu.
6. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning Menu Navigation to a Key
If you have multiple menus assigned in the RCP-NKM, you may want to include some navigation keys to enhance
movement through the menus.
To assign menu navigation to a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for navigation.
3. In the pop-up dialog:
a. Select Menu Navigate as the key type.
b. Select the key type using the information in Table 4.7 as a guide.
Table 4.7 Menu Navigation Descriptions
Option

Function

Home

Returns to the menu defined in Menu Number 1 on the Menu Details tab,
Menu Details frame.

Next Menu

Goes to the next menu, if one is held in the buffer.

Previous Menu

Goes to the previously used menu, if one is held in the buffer.
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Table 4.7 Menu Navigation Descriptions
Option

Function

Up Menu

Goes up a menu, as defined on the Menu Details tab, Menu Details frame.

Down Menu

Goes down a menu, as defined on the Menu Details tab, Menu Details frame.

XPoint Layer

Shows the breakaway, destination or source for any visible crosspoint keys. You
can step through the layers of a crosspoint by pressing the crosspoint layer key.

The simulated RCP-NKM in DashBoard shows the type of navigation on the selected key, for example, UP
MENU.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Unassigning a Key
If a key is not used for any function it should be unassigned.
To unassign a key from any function

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to unassign from a function.
3. In the pop-up dialog, select Clear key as the key type.
The simulated RCP-NKM in DashBoard shows UN-ASN on the selected key.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Locking an RCP-NKM
You can use the DashBoard to lock a remote control panel against accidental key presses. The remote control panel
can only be unlocked locally if you have assigned a panel lock or protect key. If these keys have not been assigned,
then the remote control panel may only be unlocked via DashBoard.
To lock the RCP-NKM

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Configuration frame.
4. Select the Panel Locked check box.
5. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).
The remote control panel is locked.
• If a panel lock key is assigned, this may be pressed to unlock the remote control panel.
• If a protect key is assigned, this may be held down for 3 seconds to lock/unlock a panel.
• If neither of these keys are assigned, the remote control panel can only be unlocked by clearing the Panel
Locked check box, then sending this document to the device.

Setting Up Cutbus Operation
Cutbus operation is a mode where all the keys are set as source keys for one or two destinations (or buses).
Multi-bus Cutbus mode enables groups of crosspoint keys with the same destination.
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Cutbus operation is automatically invoked when there are no destination keys or crosspoints set on the RCP-NKM.
By default, all sources in the top row of the RCP-NKM go to the destination that is physically connected to
output 1. All sources in the bottom row of the RCP-NKM go to the destination that is physically connected to
output 2.
To set up Cutbus operation

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Ensure that there are no destinations or crosspoints assigned to any keys on the RCP-NKM at any menu level.
3. Select the Configuration tab.
4. Scroll to the Configuration frame.
5. Select either Normal or Multi from the Cutbus Mode options;
• Normal — enables top row source buttons to control destination as selected via Cutbus Dest 1 option, and
bottom row source buttons to control Cutbus Dest 2.
• Multi — enables more than two Cutbus control destinations. This mode requires a group of crosspoint keys
defined with different source selection for a given destination. Refer to “Assigning a Crosspoint to a Key”
on page 4–11.
6. If you want to assign a destination other than output 1 for the top row of keys on the RCP-NKM, use the up and
down arrows in the Cutbus Dest 1 field to assign the new destination.
7. If you want to assign a destination other than output 2 for the bottom row of keys on the RCP-NKM, use the up
and down arrows in the Cutbus Dest 2 field to assign the new destination.
8. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Setting Up Machine Control
If your routing switcher system uses a machine control routing switcher to provide reciprocal switching of RS-422
signals, your RCP-NKM must be set up to handle these switches. Machine control must be enabled in the
RCP-NKM, and the router level used for machine control must match that set in the machine control routing
switcher.
To set up machine control

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Configuration frame.
4. Select the Machine Control Enabled check box.
5. Use the up and down arrows in the Machine Control Level field to adjust the machine control level to match
the level that the machine control routing switcher has been assigned.
6. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a Machine Control Key
If your master device controls multiple slave devices, you need a machine control key to temporarily disable
reciprocal switching until the last slave device is routed.
To assign a machine control key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use for machine control.
3. In the pop-up dialog:
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a. Select Function Key as the key type.
b. Select MC Key.
The simulated RCP-NKM in DashBoard shows MC KEY on the selected key.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Assigning a De-assign Key
To assign a de-assign key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. On the simulated RCP-NKM, select the key that you want to use to de-assign a machine control port.
3. In the pop-up dialog:
a. Select Function Key as the key type.
b. Select Deassign.
The simulated RCP-NKM in DashBoard shows DE-ASN on the selected key.
4. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Setting Up Virtual Routing and Resource Management
The routing systems described in this use physical switching only. That is, source 1 on level 1 refers to the first
socket on the back of a routing switcher assigned to level 1. When an NK-VRC Virtual Routing Core is added to the
system, virtual routing is possible. With virtual routing, physical inputs and outputs are mapped to virtual sources
and destinations. For example, a virtual source may switch input 15 on level 1 and input 27 on level 2.
The RCP-NKM must have virtual routing enabled to use this feature. When virtual routing is enabled, the sources
and destinations that you assign on the RCP-NKM refer to the virtual sources and destinations, as defined in the
NK-VRC.

 Virtual Routing must be enabled when using the RCP-NKM with an Ultrix routing system.
Additionally, resource management may be implemented on the NK-VRC to manage routing of different signal
types between one or more routers using external resources.
For More Information on...

• setting up and using an NK-VRC see the NK-VRC Virtual Routing Core User Guide.
To set up virtual routing and resource management

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Configuration frame.
4. Do one of the following:
• If you want to enable virtual routing, select the Virtual Routing Enabled check box.
• If you want to disable virtual routing, clear the Virtual Routing Enabled check box.
5. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).
To assign a DE-ASSIGN key

Refer to the section “Assigning a De-assign Key” on page 4-20.
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Setting the Retry Time for a Switch Failure
When you make a switch, a switch request is sent from the RCP-NKM to the routing switcher. If the RCP-NKM
does not receive a response from the routing switcher, the RCP-NKM retries the request after the time specified in
the Comms Retry Delay Factor field.
Systems require different retry times, depending on the transfer of requests and responses between modules.
Table 4.8 Retry Time
System

Retry time
(ms)

Direct T-Bus RCP to router communications

10

Using NK-VRC in the system

20

Communications via IP networks (including Ultrix)

80

NK Series Hub

250

To set the retry time

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Configuration frame.
4. Use the up and down arrows in the Comms Retry Delay Factor field to adjust the retry time according to the
requirements of your routing switcher system (see Table 4.8).
5. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Setting Up the Backlighting on the RCP-NKM
You can set up the backlighting for the keys on the RCP-NKM so that you can distinguish between whether or not
they are active. You can set the minimum level of backlighting so that it can be read in a darkened room when it is
not active, and the maximum level so that it is not too bright when it is active.
To set the level of backlighting on a key

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll down to the Configuration frame.
4. Use the up and down arrows in the On Brightness field to adjust the backlighting of a key when it is active.
The default value is 55.
5. Use the up and down arrows on the Off Brightness field to adjust the backlighting of a key when it is not
active.
The default value is 50.
6. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).

Returning to the Home Menu
You can use the DashBoard to return to the Home menu if the RCP-NKM is not responding to key presses.
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To return to the Home menu

1. Open the RCP-NKM editor for the remote control panel that is not responding (see “Opening the RCP-NKM
Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Configuration frame.
4. Select the Return to Home Menu check box.
5. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).
The RCP-NKM returns to the Home menu.

Loading Factory Defaults
If you need to return the RCP-NKM to a known configuration, you can use DashBoard to load the factory defaults.
To load the factory defaults

1. Open the RCP-NKM editor for the remote control panel that needs factory defaults loaded (see “Opening the
RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the bottom of the Configuration tab.
4. Select the Load Factory Defaults check box.
5. Send the current document to the device by clicking Send Configuration located on the lower Device
Configuration window (see “Sending a Document to a Device” on page 4–23).
The factory defaults are loaded.

Saving the Current Document for the RCP-NKM
The parameters that you have set up on the device tab for an RCP-NKM are stored in a configuration document.
When you have finished making changes to the configuration of the RCP-NKM, you should save the document,
then add the location of this document to the File Explorer pane so that you can open it later.

Saving a New Document
To save a new document

1. Select the device tab containing the document that you want to save.
2. In DashBoard, right-click the device in the Device Tree.
3. Click Save As....
4. Navigate to the folder in which you want to save the configuration document.
5. Click Save.

Adding a Directory to File Explorer
To add the document location to the File Explorer pane

1. Right-click on

in the File Explorer pane.

2. Click Add Directory...
3. Navigate to the folder in which you saved the configuration document.
4. Click Add.
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The folder and any saved documents may now be accessed via the File Explorer pane.

Opening a Saved Document
To open a saved document

1. In the File Explorer pane, navigate to the saved configuration document that you want to open.
2. Double-click the icon for the document.

Sending a Document to a Device
When you have made changes to the configuration of a device, the changes are not activated in the device until the
document containing the changes is sent to the device. You can open a saved configuration document, make
changes to it, save it, then send it to a device.
To send the current document to a device

1. Click Send Configuration (located on the lower Device Configuration pane).
• The Send Config to NK Device dialog automatically selects configuration pages with changed values for
sending. You may select all tables by checking the Select Pages if desired.
• The Send Config to NK Device dialog also lists similar devices within your routing system network. Smart
Paste is automatically selected for devices that are of a similar type but not directly related to the current
configuration document. This ensures only compatible data will be sent to other devices.
• Any of the pages containing information that has been changed are automatically selected for sending to the
device.
2. Select the pages that you want to send to the device. Use the information Table 4.9 as a guide.
Table 4.9 Page Descriptions
Page

Description

Home

The information contained in the Device Details frame and the
Configuration tab.

Key Definitions

The information defining how keys have been assigned.

Menu Details

The information contained on the Menu Details tab.

Labels

The information contained in the combined pool of input and output labels.

Input Assign

The information contained on the Input Assigns tab.

Output Assign

The information contained on the Output Assigns tab.

3. Select the device to which you want to send the current document from the Select Devices list.
4. Click OK.
5. In the IPS Explorer pane, right-click on the device, then select Reload This Device.

Printing Labels for the Front of the RCP-NKM
You can remove the facing panel from the RCP-NKM to access the keys. Transparent labels may be inserted behind
the face of each key. A template for the labels is available from the Ross Video website (www.rossvideo.com).
To print and install labels for the keys on the RCP-NKM

1. Open the RCP-NK1_Label_entry.pdf template from the Ross Video website.
2. Enter the labels directly onto the corresponding keys, then update the label set as required.
3. Print the labels onto an overhead transparency sheet following the directions provided in the template.
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4. Cut out each label to a size of 9.5 mm × 9.5 mm.
5. Disconnect power from the RCP-NKM.
6. Remove the facing panel from the RCP-NKM by gently levering it away from the frame.
7. Insert the corresponding labels into the keys so that they display correctly.
8. Position the facing panel over the frame, then push it back into place.
9. Connect the appropriate power supply to the RCP-NKM.
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Operating the RCP-NKM
 Before using the RCP-NKM, ensure that the labels for the keys have been placed correctly behind the keys (see
“Printing Labels for the Front of the RCP-NKM” on page 4–23).

LCD Screen
The LCD screen shows the status of the current source, destination, and any status indicators. For help on adjusting
the contrast, see “Adjusting the Contrast for the LCD” on page 5–10.
Chop indicator

Source label

Protection indicator

Destination label

Breakaway warning indicator

Figure 5.6 Features of the Screen on the RCP-NKM

Default Screen
The default screen shows the currently selected destination and source. If you select another destination, the name
of this destination is shown in the bottom line of the screen, and the name of the last-selected source for that
destination is shown in the top line of the screen, and the corresponding keys on the RCP-NKM are illuminated.

 Pressing destination keys does not cause a routing switcher to switch. A switch is only made when you press a
source/crosspoint/macro key, or the TAKE key (if assigned).

Figure 5.7 Example of the Default Screen

Message Screen
A message screen describes an activity or the status of levels in a breakaway. It returns to the default screen after a
brief pause.

Figure 5.8 Examples of a message screen

 The message screen remains for as long as a breakaway step key is held.
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Error Screen
An error screen appears briefly when the routing switcher sends a response back to the RCP-NKM indicating that it
cannot complete the request.

Figure 5.9 Examples of an Error Screen

Breakaways and Levels
Breakaways are made up of one or more levels that are defined as a level mask, then assigned to a key (see “Setting
Up Breakaways” on page 4–6). You can assign multiple breakaway keys to an RCP-NKM. You can select only one
breakaway for a switch.
One level may be assigned to a key. You can assign multiple level keys to an RCP-NKM. You can select multiple
level keys prior to a switch.

Selecting Breakaways and Levels
To select a breakaway or level

1. Press the corresponding key.
The key illuminates. If you have selected a custom breakaway, and separate level keys are assigned to the
RCP-NKM, the level keys corresponding to the levels in the breakaway also illuminate.
When a breakaway is selected, the status of the routing switcher shown on the LCD is the status of the lowest
router level in the breakaway.
If a breakaway warning is indicated on the LCD, it shows the routing switcher status in the current breakaway
when compared to the router levels defined in the breakaway in the configuration.
Notes
Keep the following in mind:
• You cannot add a level to a custom breakaway by pressing a level key.
• A breakaway warning is caused by:
› no response from the routing switcher system on one or more router levels
› a difference in status of any level in the currently selected breakaway when compared with the first level in the
breakaway
To de-select a breakaway

• Select another custom breakaway, the default breakaway, or a level key.
To de-select a level

• Press the level key again.
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Viewing the Breakaways Assigned to an RCP-NKM
You can view the breakaways assigned to an RCP-NKM if a breakaway step key is assigned to the RCP-NKM. The
breakaway step key cycles to the next breakaway in the list each time it is pressed. As each breakaway is selected,
the level(s) defined in that breakaway are illuminated, if corresponding level keys have been assigned to the
RCP-NKM.
To view the breakaways assigned to an RCP-NKM

• Press the breakaway step key repeatedly to cycle through the available breakaways.
The breakaway step key remains illuminated as you step through the breakaways. When the default breakaway is
selected, the breakaway step key switches off.
Notes
Keep the following in mind:
• The breakaway key flashes if a warning is indicated.
• If a breakaway warning is current for the selected breakaway, the breakaway warning indicator is shown on the
screen.
To view the name and levels of a breakaway

• Hold the breakaway key.
The name of the breakaway and an 8-character expression appears on the screen. Each character provides a
hexadecimal representation of the use of four levels, from 32 to 29 on the left, through to 4 to 1 on the right.
Table 7.11 provides a look-up table for reading the levels from the hexadecimal characters.
To view the levels defined in a breakaway

1. Select the breakaway.
2. Hold the breakaway step key.
An 8-character expression appears on the screen. Each character provides a hexadecimal representation of the
use of four levels, from 32 to 29 on the left, through to 4 to 1 on the right. Table 7.11 provides a look-up table
for reading the levels from the hexadecimal characters.

 If level keys have been assigned to the RCP-NKM, these illuminate as part of the breakaway. The level keys are
not illuminated when the default breakaway is selected.

Making a Switch
A switch can be made with or without a TAKE key assigned to the menu. If there is no TAKE key assigned, a
switch is made when the source/crosspoint/macro key is pressed. If a TAKE key is assigned to the menu, the switch
is made when the TAKE key is pressed.

Switching with a Breakaway, Destination, and Source
To make a switch

1. Press the key(s) for the level(s) or breakaway that you want to use.
If you do not select a custom breakaway or level key, the default breakaway is used.
To de-select a level, press the key again.
2. Press the destination key that you want to use.
3. Press the source key that you want to use.
If a TAKE key is assigned to the menu, the text on the screen that identifies the source key alternates between
Take ? and the selected source label. The source key flashes with the TAKE key.
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4. If a TAKE key is assigned to the menu, press TAKE.
5. If you want to protect the destination, press the protect key, if it has been assigned (see “Protecting a
Destination” on page 5–5).
Notes
Keep the following in mind:
• You may need to use a DST SH1 or DST SH2 key before the destination key.
• If you are in Cutbus mode, you cannot select a destination key.
• You may need to use a SRC SH1 or SRC SH2 key before the source key.
• If you have selected the Breakaway Reset check box in the configuration document for the RCP-NKM, the
breakaway returns to the default breakaway after the switch is made.

Switching with a Crosspoint
To make a switch using a pre-defined crosspoint key

1. Press the crosspoint key.
If a TAKE key is assigned to the menu, the text on the screen that identifies the source key alternates between
Take ? and the selected source label. The crosspoint key flashes with the TAKE key.
2. If a TAKE key is assigned to the menu, press TAKE.
3. If you want to protect the switch, press the protect key, if it has been assigned (see “Protecting a Destination”
on page 5–5).
Notes
Keep the following in mind:
• When you make a crosspoint switch, the corresponding breakaway, destination, and source keys illuminate.
• If you have selected the Breakaway Reset check box in the configuration document for the RCP-NKM, the
breakaway returns to the default breakaway after the switch is made.

Using a Macro
You can use macros on the RCP-NKM.
To use a macro

1. Create a macro (see “Assigning a Macro to a Key” on page 4–13).
2. Press the macro key.
If a TAKE key is assigned to the menu, the text on the screen that identifies the source key alternates between
Take ? and the selected source label for the last source key in the macro. The macro key flashes with the
TAKE key.
3. If a TAKE key is assigned to the menu, press TAKE.

Locking the RCP-NKM
You can lock the RCP-NKM if a panel lock or protect key has been assigned to the RCP-NKM.
The protect key must be held to lock the RCP-NKM.
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To lock the RCP-NKM using a panel lock key

1. Press the panel lock key.
The panel lock key illuminates. A brief KEY LOCK message is shown on the screen.
Every key on the RCP-NKM becomes inactive, except for the panel lock key.
2. If you want to unlock the RCP-NKM, press the panel lock key.
The panel lock key switches off. A brief KEY UNLOCK message is shown on the screen.
To lock the RCP-NKM using a protect key

1. Hold the protect key for 3 seconds.
A brief KEY LOCK message is shown on the screen.
If a panel lock key is assigned to the RCP-NKM, this key illuminates.
Every key on the RCP-NKM becomes inactive, except for the protect key, and panel lock key, if assigned.
2. If you want to unlock the RCP-NKM, hold the protect key or press the panel lock key, if assigned.
A brief KEY UNLOCK message is shown on the screen.

 The protect key does not illuminate.

Protecting a Destination
You can use a protect key to prevent switching of critical crosspoints by others. The protect function ensures that
the selected destination can only receive the selected source across the selected levels. Once protected, the selected
levels on a destination cannot be switched by other remote control panels (or by the same remote control panel if
Block All Panels is selected). The source is not protected, and can be freely routed to other destinations if required.
You can protect any number of destinations.
You can set the extent of protection that is used, that is, protected against other remote control panels or protected
against all remote control panels, via the DashBoard (see “Assigning a Protect Key” on page 4–14).
To protect a destination

1. Make the switch.
2. Press the protect key.
The protect key and the protected crosspoint are illuminated. The screen indicates that a protect is in place by
showing the protection indicator at the bottom left of the screen.

 If you are protecting a destination on a level for which a routing switcher does not respond, a protect breakaway
error (*PROT BRKWY ERR*) occurs.
To remove the protection from a destination

1. Press the key for the protected destination.
2. Press the protect key.
The protection indicator is removed from the screen.
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Clearing Protects Held by an RCP-NKM
A protect that is held by an RCP-NKM prevents the crosspoint being changed by another user. A protect can be sent
to the routing switcher from any connected remote control panel. Protects can be applied at any time, and are only
visible when the particular destination is selected.
To clear one protect from an RCP-NKM

1. Press the destination key that has the protection applied.
The protection indicator is shown at the bottom left of the screen.

2. Press the protect key.
To clear all of the protects from an RCP-NKM

1. Open the RCP-NKM editor for the remote control panel that you want to clear (see “Opening the RCP-NKM
Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Configuration frame.
4. If you want to clear all protects held by the RCP-NKM, select the Clear Protect(s) check box.
5. Send the current document (see “Sending a Document to a Device” on page 4–23).

 Protects may be held by other remote control panels. Each remote control panel attached to a routing switcher
has to have its protects cleared separately.

Toggling Between Two Sources
If a CHOP key has been assigned to the RCP-NKM, you can use this key to toggle between two sources.
To toggle between two sources:

1. Press the key for the destination on which you want to receive the sources.
2. Press the key for the first source that you want to receive, followed by the TAKE key, if assigned.
3. Press the key for the second source that you want to receive, followed by the TAKE key, if assigned.
4. Do one of the following:
• Press CHOP once to toggle slowly between the two sources (toggle cadence is 1700 ms). The source label
on the screen toggles between the two sources. Slow chop is indicated by a lower-case c.
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• Press CHOP twice to toggle rapidly between the two sources (toggle cadence is 400 ms). The source label
on the screen toggles between the two sources. Fast chop is indicated by an upper-case C.

5. Do one of the following:
• If you are in slow chop, press CHOP twice to stop toggling between the two sources.
• If you are in fast chop, press CHOP once to stop toggling between the two sources.
The status of the key returns to CHOP.

Using a Menu
The key corresponding to the current menu is always illuminated.
To use a menu

1. Press the key that has the menu assigned to it.
A brief message is shown on the screen with the name of the menu. For example:

2. Press the key that you want to use in that menu.
If the menu has been set up to fall back to another menu, the RCP-NKM goes to the pre-defined menu (see
“Setting Up Menus” on page 4–7).

 If you need to return to the Home menu, but the RCP-NKM is not responding, use the DashBoard to do this. For
more information see “Returning to the Home Menu” on page 4–21.

De-Assigning a Machine Control Port
If you want to stop machine control on a particular port temporarily, you can park the port by de-assigning it.
To de-assign a machine control port

1. Press the key for the machine control port that you want to park.
2. Press DE-ASN.
To unpark the machine control port

• Make a machine control switch.
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De-Assigning Resources
De-assigning resources can be done in two ways:
• Route a different source to that destination that does not require a resource. The assigned resource will
automatically be de-assigned.
• Use the de-assign button.
To-deassign a resource

1. Select the destination to which the resource is attached.
2. Press DE-ASIGN.
If the selected destination does not include a resource, one of two things will occur:
• If the panel is in MC mode, park the current destination (switch same source number to destination).
• If the panel is not in MC mode, it displays the MC MODE? message.

 The ability of a panel to de-assign a resource using the DE-ASIGN button will depend on the priority assigned to
the panel and the resource in the NK-VRC virtual routing core.

Operating Linked Remote Control Panels
You can link RCP-NKMs together, or link them with RCP-NKMs. The remote control panels must have panel link
addresses set, as described “Linking Remote Control Panels” on page 4–4. Once these addresses are set correctly,
the remote control panels transfer status, request and response information between them. Effectively, the remote
control panels combine to form one big remote control panel. Up to 255 remote control panels may be linked
together.
If you want to define all the crosspoints that you need without using menus and pages, you need as many keys as
there are crosspoints.

 The input and output assign labels should be identical across all remote control panels.
Function Keys
Once remote control panels are linked, they operate in a similar manner as the unlinked state. If a special function
key (CHOP, DST/SRC SH1/SH2, DE-ASN, or a panel lock, protect, breakaway, breakaway step or machine
control) is assigned to one remote control panel, it is effective across all linked remote control panels, regardless of
the location of other relevant keys.
Notes
Keep the following in mind:
• A TAKE key does not operate across menus within the same remote control panel however, it does operate
across linked remote control panels as long as it is on a current menu at the time that the source/crosspoint/macro
key is pressed.
• If a TAKE key is assigned, the selected source/crosspoint/macro key and the TAKE key flash to indicate that the
remote control panel is waiting for TAKE to be pressed.

Destinations and Sources
Destinations and sources from different remote control panels may be switched.

Crosspoints
Crosspoints can only be programmed to a remote control panel via the DashBoard, so these are specific to the
remote control panel.
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Switching
When a breakaway, destination and source are sent in a switch request from a remote control panel, each linked
remote control panel receives the level mask, destination and source information via a linked panel message, and
either reflects the status, or behaves accordingly (for example, locking the remote control panel or entering macro
record mode).

Breakaways
Breakaway numbers are not sent in the switch request, thus removing the need for identical breakaway definitions
across linked remote control panels. As such, breakaway step is not available across linked remote control panels.
You can view the breakaways within the same remote control panel, in line with unlinked behaviour.

Menus
Menus and menu navigation keys are only effective on the remote control panel to which they are assigned.

Macros
Macros may be recorded or added across linked remote control panels.

Resetting Devices
If you want to return to a known operating state and configuration, you can:
• send the default document to the RCP-NKM (see “Sending a Document to a Device” on page 4–23)
• reset the device
• reload the factory defaults
If the RCP-NKM fails to accept any documents that are sent to it, then you should reset the device. When you
perform a reset, the RCP-NKM takes on the last-known operating state and configuration that is stored in memory.
If the RCP-NKM fails to reset, then reload the factory defaults via a web browser.
To reset a device

• In the IPS Explorer pane, right-click on the RCP-NKM that you want to reset, then select Reset Device.

Viewing Status and Alarms
An indication that alarms are present for a device is visible in the IPS Explorer pane. If a device has one or more
alarms, a small circle appears in the icon for the device.
status/alarm indication

Figure 5.10 IPS Explorer pane showing device with status/alarm indication
To view the status and any alarms for an RCP-NKM

1. Open the RCP-NKM editor (see “Opening the RCP-NKM Editor” on page 4–1).
2. Select the Configuration tab.
3. Scroll to the Alarms frame.
The status of the RCP-NKM is shown via a number of colored buttons and labels.
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Adjusting the Contrast for the LCD
To Adjust the contrast

1. Insert a Phillips head screwdriver into the Display Contrast trimpot on the rear panel of the RCP-NKM.
2. Adjust the trimpot until the contrast suits your environment and viewing requirements.
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Troubleshooting
Table 6.10 Troubleshooting
Problem

Cause

Action

I am stuck on a menu
with no way back

A return loop was not set
up when the menu was
defined.

Return to the Home menu as outlined in “Returning to the
Home Menu” on page 4–21.

RCP-NKM is not
responding to DashBoard

Information stored in the
RCP-NKM has been
corrupted.

Try the following until the RCP-NKM responds:

The RCP-NKM is not
switching correctly

The NK Series devices
are not set up correctly to
operate with or without
virtual routing.

Set up the devices with virtual routing enabled or disabled, as
required (see “Setting Up Virtual Routing and Resource
Management” on page 4–20).

I get a PROT BRKWY
ERR when the
PROTECT button is
pressed

At least one crosspoint
across the router levels
defined in the current
breakaway does not exist.

Determine which level is causing the breakaway warning,
then:

• Power cycle the RCP-NKM
• Send the default document to the RCP-NKM

• connect the source and destination equipment so that the
particular crosspoint will work, or
• remove the router level from the breakaway definition.

The RCP-NKM takes a
long time for switch
response to be displayed

The current breakaway is
trying to switch a level
when there is no router
configured for that level

Ensure the current breakaway only includes levels matching
connected routers

The display briefly
indicates NO RESP

The RCP-NKM times out
while waiting for
response from router/s

Increase the Comms Retry Delay configuration item. Refer
to “Setting the Retry Time for a Switch Failure” on page 4–
21.
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Hexadecimal to Router Level
Conversion
The router level is represented by eight hexadecimal characters. For each hexadecimal character, read the
corresponding binary representation across the table.
For each ‘1’ that appears in the binary representation, drop down to the Level row to read the actual router level
included in the mask. For example, 0AB50221 represents levels 28, 26, 24, 22, 21, 19, 17, 10, 6, and 1.
Table 7.11 Look-up table for hexadecimal to router level conversion
Hexadecimal
0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F
Level

1st character

Level

3rd character

4th character

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

32

31

30

29

28

27

26

25

24

23

22

21

20

19

18

17

Hexadecimal
0
1
2
3
4
5
6
7
8
9
A
B
C
D
E
F

2nd character

5th character

6th character

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

16

15

14

13

12
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0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1
11

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1
10

7th character

9

8

7

6

5

4

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

0
0
1
1
0
0
1
1
0
0
1
1
0
0
1
1

0
0
0
0
1
1
1
1
0
0
0
0
1
1
1
1

0
0
0
0
0
0
0
0
1
1
1
1
1
1
1
1

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

8th character

3

2

1
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